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1. AnyLink 소개
본 장에서는 AnyLink에 대한 개념적 이해를 목적으로 하며 구성 개요 및 주요 특징에 대해서 설명한다.

1.1. 개요
엔터프라이즈 환경에서 시스템 상호 간에 연계 필요성이 높아지고 표준화되지 않은 Peer-to-Peer 방식으로
구축함으로써 점점 복잡해지는 인터페이스를 통합적이고 표준화된 방식으로 관리하기 위해 인터페이스 시스템을
구축하게 된다.

다음은 대표적인 인터페이스 시스템이다.

• 엔터프라이즈 애플리케이션 연계 시스템(EAI, Enterprise Application Integration)

• 엔터프라이즈 서비스 버스 시스템(ESB, Enterprise Service Bus)

• 멀티채널 인터페이스 시스템(MCI, Multi-Channel Interface)

• 대외채널 시스템(FEP, Front End Processor)

인터페이스 시스템은 공통기능과 유사한 특성을 갖고 있지만 소프트웨어 시장에서는 이들이 기반으로 하는
솔루션들이 연계 영역별 특성에 맞게 특화되어 제작되고 공급되어 왔다. 시스템이 다양화되고 복잡해지면서 연계
특성에 따라 다른 벤더의 솔루션 기반으로 개별적인 개발/운영 방식을 구축한 시스템에서 통합이나 표준화 문제가
발생하게 되었다.

AnyLink는 이러한 문제점을 해결하기 위해 엔터프라이즈 시스템의 인터페이스들을 단일 아키텍처로 가상화하고,
대내외에서 발생하는 다양한 대용량 데이터를 신속하게 처리하고 전달하는 채널 인터페이스 백본으로 설계되었다.

또한 다양한 인터페이스 시스템을 연계 특성에 맞게 구성할 수 있도록 플랫폼으로 제공하며, 모든 시스템들이
통합적으로 개발되고 운영될 수 있도록 통합 개발/운영 환경을 제공한다. 대규모 비즈니스 환경에서 신속한
인터페이스 통합 및 확장, 채널의 다변화를 안정적으로 수용할 수 있는 클라우드 인프라를 기반으로 하는 클라우드
플랫폼으로 제공된다.

1.2. 구성
AnyLink는 스튜디오(Studio), 리모트 에이전트(Remote Agent), 런타임 엔진(RTE), WebAdmin, 데이터 통합
서버(DIS)로 구성된다.
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AnyLink 구성도

• 스튜디오(Studio)

통합개발환경(IDE)으로 거래와 관련 자원들을 정의할 수 있는 Eclipse 기반의 툴로 거래, 메시지, 메시지 맵핑,
파싱룰, 플로우, 아웃바운드 룰, 유저 클래스(User Class)를 정의할 수 있는 환경을 제공한다. Studio를 통해
정의된 자원들을 DIS에 저장한 후 RTE에 배포하게 되며, DIS에 저장된 자원을 다운로드 받아 개발을 진행할 수
있다.

• 리모트 에이전트(Remote Agent)

원격지에서의 거래 송수신 처리를 하기 위해서는 원격지 서버의 리모트 에이전트를 통해 처리할 수 있다. 리모트
에이전트는 어댑터 엔드포인트 역할을 대신하여 인바운드/아웃바운드 메시지를 송수신하며 허브의
엔드포인트와 TCP Tunneling으로 메시지를 전달하거나 전달받는다.

• 런타임 엔진(RTE, Runtime Engine)

런타임 엔진은 리소스 매니저, 어댑터, 딜리버리 채널, 플로우 엔진으로 구성되어 있다.

구분 설명

리소스 매니저 런타임 환경의 공통 자원을 관리하며 클래스 로더, 스레드 풀, 거래 및 설정을 관리한다.

어댑터 메시지 송수신, 파싱, 마샬(Maschal)/언마샬(Unmaschal) 및 서비스를 호출한다.

딜리버리 채널 호출된 서비스의 위치를 찾아서 플로우, 아웃바운드 룰, 멀티바인딩를 실행하고 메시지를
전달하는 역할을 한다.

플로우 엔진 스튜디오에서 정의된 플로우 흐름과 조건에 따라 액티비티(Activity), 이벤트(Event),
게이트웨이(Gateway)를 순차 혹은 병렬로 실행한다.

• WebAdmin

WebAdmin은 운영관리 툴로 시스템 구성관리, 운영설정, 모니터링, 사용자/권한관리를 한다.
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구분 설명

시스템 구성관리 여러 개의 업무시스템을 정의와 관리를 허용하며, 업무시스템은 싱글 서버 클러스터나
싱글 서버로 구성될 수 있다.

원격 망에서의 연계를 위한 리모트 에이전트(Remote Agent)도 업무시스템에 추가될 수
있다. 각 업무 시스템마다 어댑터를 정의하고 스튜디오에서 정의한 거래를 맵핑하여 거래
요청 메시지가 왔을 때 거래를 식별하고 처리되도록 한다.

운영설정 RTE 설정, 거래제한, SLA 설정, 로깅설정, 잡/스케줄러 설정관리를 한다.

모니터링 실시간 성능 모니터링과 일별 통계를 지원하며 사용자관리와 자원에 대한 권한관리를
제공한다.

• 데이터 통합 서버(DIS, Data Integration Server)

데이터 통합 서버로 스튜디오에서 정의된 자원과 Admin에서 정의된 구성 및 설정 정보를 Repository에
저장하고 관리해 준다. 자원과 설정 정보는 RTE에 필요한 형태로 가공한 후 배포되며, 모니터링을 위해 RTE 성능
정보를 실시간으로 쿼리하거나 DB에 저장된 트랜잭션 정보의 통계를 계산한다. DIS는 JEUS DAS(Domain
Administration Server)를 통해 JEUS 도메인 구성정보, 데이터소스 등의 정보를 쿼리하여 AnyLink 구성을
용이하게 한다.
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2. AnyLink 서버
본 절에서는 AnyLink 서버 구성과 디렉터리 구조에 대해서 설명한다.

2.1. 서버 구성
AnyLink는 크게 실행 환경과 개발 및 배포 환경 두 가지 형태로 구분해볼 수 있다. 실행 환경은 AnyLink 런타임 엔진
서버들과 연계 대상 시스템들로 구성되며, 연계 대상 시스템들의 구성과 형태에 따라 몇 가지 형태를 갖는다.

개발 및 배포 환경은 배포를 담당하는 서버인 데이터 통합 서버와 실행 서버인 런타임 엔진 서버 그리고 각종 룰과
환경 정보를 작성하는 클라이언트인 스튜디오와 WebAdmin으로 구성된다.

AnyLink 개발 및 배포 구성 형태

AnyLink는 개발 및 배포 서버인 데이터 통합 서버(DIS)와 운영 서버(RTE)를 분리하여, 실제로 운영을 하는 경우에는
배포 서버인 DIS의 기동 여부와 상관없이 RTE 서버가 서비스를 정상적으로 실행되도록 설계되어 있다.

개발 및 배포를 담당하는 DIS는 업무 개발을 위한 통합 스튜디오와 운영 및 모니터링을 위한 WebAdmin에서
요청하는 각 명령들을 처리하는 역할을 한다. DIS는 스튜디오로부터 전달받은 개발 리소스들을 런타임 엔진 서버로
배포하고 이력 관리를 한다. DIS는 개발 리소스를 관리하고 로그 통계 등 모니터링 정보를 제공하기 위하여
RDBMS를 필요로 한다.
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2.2. 디렉터리 구조
AnyLink 서버가 설치되면 다음과 같은 디렉터리가 생성된다.

$AnyLink_HOME/jeus7
   +---- bin
   +---- db_scripts
   +---- dis_config
   +---- domains
   +---- anyLink-licenses
   |----lib
         +----anylink
         +----client
         +----datasource
         +----endorsed
         +----etc
         +----jext
         +----licenses
         +----schemas
         +----shared
         +----system
         +----systemapps
         +----thirdparty
   +---- license
   |---- logs
           +---- AnyLink
   +---- nodemanager
   +---- server

bin

서버의 시작 및 종료 스크립트인 startDomainAdminServer, startManagedServer, stopServer와 JEUS
콘솔 툴(jeusadmin)과 같은 실행 파일들이 위치한다.

db_scripts

AnyLink를 사용하기 위한 DB 스크립트 파일이 위치한다.

dis_config

dis-config.xml 파일이 위치한 곳으로 DIS 서버의 환경정보가 위치한다.

domains

하위에 도메인별로 DOMAIN_HOME과 JEUS_HOME에서 사용하는 노드 정보가 포함된 nodes.xml이
존재한다.

anyLink-licenses

AnyLink에서 사용하는 오픈 소스들에 대한 라이선스 파일이 위치한다.

lib

JEUS가 기동하는 데 필요한 라이브러리가 존재한다. shared 디렉터리를 제외한 나머지 디렉터리들은 사용자가
접근할 필요가 없다.
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license

JEUS 라이선스 파일이 위치한다. 라이선스 파일은 JEUS가 실행되기 위해서 반드시 필요한 파일이다.

logs

AnyLink 로그 파일들이 위치한다.

nodemanager

JEUS 노드 매니저를 위한 설정 파일인 jeusnm.properties 파일이 위치한다.

server

DIS 서버에서 사용되는 파일들이 위치한다.
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3. AnyLink WebAdmin
본 장에서는 WebAdmin의 기본 화면, 메뉴 구성에 대해서 설명한다.

3.1. 시작하기
AnyLink WebAdmin은 웹 브라우저를 통해 AnyLink를 관리하는 사용자 애플리케이션이다. WebAdmin을 통해
AnyLink의 각종 설정을 제어하고 관리할 수 있으며, 실시간 모니터링이 가능하다.

인스톨러를 통해 AnyLink WebAdmind을 설치했다면 다음의 방법을 통해 WebAdmin을 시작한다.

1. WebAdmin에 접속하기 위해 웹 브라우저에서 다음과 같은 형식의 주소를 입력한다. 포트는 Domain Admin
Server에서 설정한 http port이다. (예: 8808)

http://{서버IP 주소:포트}/anylink-admin

2. 정상적으로 접속된 경우 다음과 같은 로그인 화면이 나타난다.

사용자 아이디와 비밀번호를 입력한 후 [Log in] 버튼을 클릭한다. WebAdmin의 최초 아이디와 비밀번호는
각각 'admin', 'admin’으로 설정되어 있다.

로그인 화면

admin 계정으로 로그인한 후에 비밀번호를 수정할 수 있다. 비밀번호의 수정 방법은 "비밀번호 변경"을
참고한다.

3. 정상적으로 로그인되면 WebAdmin 메인 화면으로 이동한다. 화면의 각 구성에 대한 자세한 내용은 화면 구성을
참고한다.
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WebAdmin 메인 화면

4. AnyLink WebAdmin 화면의 오른쪽 상단에 위치한 사용자 정보 영역의 [로그아웃] 메뉴를 선택하면
WebAdmin에서 로그아웃되고 로그인 화면으로 이동한다.

 

비밀번호 변경

비밀번호를 변경하는 방법으로 2가지가 있다.

시스템의 안전한 관리를 위하여 admin 계정으로 최초로 로그인한 후에는 비밀번호를 변경할
것을 권장한다.

• 방법 1)

AnyLink WebAdmin 메뉴에서 [관리자] > [사용자]를 선택하면 사용자 목록을 조회한 후 변경할 사용자 계정을
클릭하면 사용자정보 조회 화면이 나타난다. 화면에서 '비밀번호'와 '비밀번호 확인' 항목에 새로운 비밀번호를
입력하고 [저장] 버튼을 클릭한다. 각 항목에 대한 자세한 내용은 AnyLink WebAdmin 안내서의 "사용자 등록
"을 참고한다.
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관리자 비밀번호 변경

• 방법 2)

오른쪽 상단의 사용자 정보 영역을 클릭하여 드롭다운 메뉴에서 [사용자 정보 수정]을 선택해서 비밀번호를
변경할 수 있다. 조회된 사용자 정보에서 '비밀번호'와 '비밀번호 확인' 항목을 수정한 후 (저장) 아이콘을
클릭한다.

[사용자 정보] - [사용자 정보 수정]

3.2. 화면 구성
다음은 WebAdmin의 화면 구성에 대한 설명이다.
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WebAdmin 화면 구성

• (1) Home & 메뉴 영역

AnyLink의 로고를 클릭하면 [구성관리] > [업무시스템] 메뉴로 이동한다.

상단의 메뉴를 클릭하면 해당 메뉴의 서브 메뉴를 선택할 수 있다. 각 화면의 기능과 사용법은 "AnyLink
WebAdmin 안내서"를 참고한다.

◦ [구성관리]

메뉴 설명

[업무시스템] 업무시스템, 리모트 에이전트를 등록/수정/삭제한다.

[리모트 에이전트] 원격지에 있는 여러 대의 서버를 운영비용 절감을 위해 한 곳에서 제어한다.

[어댑터] 어댑터와 어댑터의 엔드포인트를 설정한다.

[어댑터 클러스터] 업무시스템을 서버 클러스터 환경으로 생성했을 때 [어댑터], [엔드포인트 그룹],
[엔드포인트]의 리소스를 클러스터링한다.

[메시지 큐] 메시지 큐의 연결 정보를 설정한다.

[패치] AnyLink 스튜디오 또는 에이전트 패치 파일을 리모트 에이전트에 배포한다.

◦ [운영관리]

메뉴 설명

[거래 설정] AnyLink 스튜디오에서 추가한 거래들을 조회하고 거래별로 스레드 풀을
할당한다.

[스레드 풀] 거래/시스템에 따라 할당할 수 있는 스레드 풀을 관리한다.
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메뉴 설명

[로그설정] 거래/어댑터 기준으로 남기는 로그의 수준을 설정한다.

[파일 로그 설정] 거래/어댑터 기준으로 남기는 파일 로그의 수준을 설정한다.

[시스템 로그] 각 서버에서 발행되는 모든 로그의 레벨 및 위치를 설정한다.

[잡 스케줄] 반복적으로 수행되어야 하는 거래를 스케줄링하고 관리한다.

[마스킹 설정] 업무시스템의 거래 내용에 마스킹을 설정한다.

[거래 제어] 거래에 관한 전반적인 룰을 관리하는 기능을 제공한다.

[유량 제어] 거래에서 설정된 값 이상의 거래에 대한 실행 개수를 설정한다.

[업무시스템 설정] 업무시스템에 대해 전반적으로 설정한다.

[망 관리] 대외기관에서 장애전문 수신 시 장애 상태 전문을 전송한다.

[단말 관리] 단말에 대해 설정하고 관리한다.

[VAN 관리] VAN 정보를 등록 및 관리한다.

[이벤트 관리] AnyLink에서 지정한 이벤트가 발생하는 경우 이벤트에 대해 설정하고
관리한다.

[전문 공유] 배포된 메시지들을 확인 및 핸들러 호출을 수행한다.

[대외 연락처] 외부 기관의 연락처를 등록한다.

◦ [배포관리]

메뉴 설명

[배포현황] 어댑터, 엔드포인트 그룹, 엔드포인트, 거래, 거래 설정의 배포 현황을 확인한다.

[배포이력] AnyLink에 배포된 전체 리소스에 대해 배포 이력을 검색 및 확인한다.

[배포관리] AnyLink에 배포된 전체 리소스에 대해 배포해제 가능한 리스트를 확인하고
해제한다.

[리소스 삭제] 배포해제된 리소스를 삭제한다.

[이관관리] 어댑터, 엔드포인트 그룹, 거래, 엔드포인트, 공통 라이브러리 등을 이관한다.

◦ [모니터링]

메뉴 설명

[업무시스템] 로깅된 내용을 바탕으로 AnyLink에서 수행한 트랜잭션들의 상황을 보여준다.

[커스텀 로그] 거래에 대한 로그를 전문 내용으로 검색한다.

[통계] AnyLink에서 수행한 트랜잭션들 통계를 설정하고 결과를 보여준다.

[스레드 풀 모니터링] 업무시스템 내 스레드 풀을 실시간으로 모니터링한다.

[큐 모니터링] 메시지 큐에 쌓여있는 메시지 정보를 확인한다.

[대시보드] 시스템 상태를 모니터링한다.

[어댑터] 업무시스템별로 어댑터 상태를 모니터링한다.
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메뉴 설명

[배치 진행률] 배치 진행 상태를 확인한다.

◦ [관리자]

메뉴 설명

[사용자] AnyLink를 이용하는 관리자를 등록/삭제한다.

[권한관리] AnyLink를 이용하는 관리자의 권한을 등록/삭제한다.

[시스템 변수] 업무시스템별 사용 가능한 시스템 변수를 등록한다.

[메타정보관리] 카테고리별로 사용할 메타정보를 설정한다.

[DIS 설정] AnyLink DIS에 대해 전반적으로 설정한다.

[사용자 접속 이력] AnyLink를 접속한 사용자의 정보와 접속 내역을 확인한다.

[DIS 라이브러리 관리] AnyLink DIS에서 사용하는 라이브러리를 업로드한다.

• (2) 인포메이션 영역

현재 업무시스템의 상태 정보와 에러코드 정보를 조회할 수 있다.

인포메이션 영역

◦ [RUNNING], [SHUTDOWN]

등록된 업무시스템의 서버 상태가 RUNNING, SHUTDOWN인 서버 수가 표시된다. 메뉴를 클릭하면 해당
상태의 업무시스템과 서버 정보를 조회할 수 있다.

◦ [에러코드]

에러 코드별 메시지와 조치 방법을 조회한다.
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에러코드 목록 화면

◦ [JEUS]

JEUS WebAdmin이 실행된다.

• (3) 사용자 정보 영역

현재 로그인된 사용자의 ID와 NAME이 표시된다. [관리자] > [DIS 설정]의 사용자 표시 설정 영역에서 표시
형식을 변경할 수 있다. 사용자 정보 영역을 클릭하면 [사용자 정보 수정], [로그아웃] 드롭다운 메뉴가 나타난다.

◦ [사용자 정보 수정] 메뉴

사용자 정보 수정 화면에서 사용자 정보를 수정하고 (저장) 아이콘을 클릭한다. 화면에 대한 자세한
내용은 "AnyLink WebAdmin 안내서"의 "6.2. 사용자"를 참고한다.

[사용자 정보] - [사용자 정보 수정]

◦ [로그아웃] 메뉴

WebAdmin에서 로그아웃되고 로그인 화면으로 이동한다.
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• (4) 트리 영역

메뉴 영역에서 선택한 메뉴의 각 아이템(업무시스템, 어댑터, 엔드포인트)을 계층구조로 나타내는 트리로
생성한다. 생성된 트리는 '이름'과 '아이디'를 선택하면 해당 정보로 노드를 구성한다. 트리 아이템은 아이디
/이름과 함께 아이콘으로 구성된다. 트리 아이콘에 대한 자세한 내용은 "네비게이션 아이콘"을 참고한다.
트리에서 선택한 노드의 속성에 따라서 목록 화면이나 상세 화면이 컨텐츠 영역에 표시된다.

트리 상단에 입력 항목에 검색 조건을 입력한 후 <Enter> 키를 누르거나 [검색] 아이콘을 클릭하면 조건에
해당하는 정보로 트리를 다시 생성한다. [+], [-] 버튼을 클릭하면 트리에 선택한 노드를 닫거나 펼칠 수 있다.

• (5) 컨텐츠 영역

메뉴 영역과 트리 영역에 선택한 정보로 화면을 조회해서 실행하는 영역이다.

 

네비게이션 아이콘

AnyLink의 WebAdmin은 가독성을 높이고 사용자의 편의를 위해 텍스트 기반으로 모든 정보를 출력하지 않고 일부
내용을 아이콘을 통해 표현한다. 따라서 다양한 모양의 아이콘이 뜻하는 의미를 잘 숙지해두어야 할 필요가 있다.

다음은 메뉴별 트리와 작업영역에서 표시되는 아이콘에 대한 설명이다. 각 화면의 기능과 사용법은 "AnyLink
WebAdmin 안내서"를 참고한다.

• 기본 요소 아이콘

아이콘 설명

ALL 아이콘으로 모든 요소를 포함하는 최상위 항목을 의미한다. 계층구조를 지니는 각종 트리에서
주로 볼 수 있다.

업무시스템 아이콘으로 AnyLink의 가장 기본적인 논리 구조인 업무시스템을 의미한다.

서버 아이콘으로 업무시스템에 포함된 서버를 나타내는 아이콘이다.

서버 클러스터 아이콘으로 업무시스템이 서버 클러스터로 구성된 경우 볼 수 있다.

리모트 에이전트 그룹 아이콘이다.

리모트 에이전트 아이콘이다.

거래 아이콘이다.

거래그룹 아이콘이다. 참고한다.

스레드 풀 아이콘이다.

• 어댑터 아이콘

아이콘 설명

DB 어댑터 아이콘으로 데이터베이스(DB)의 프로토콜을 사용한 통신을 담당한다.

ebXML 어댑터 아이콘으로 ebXML의 프로토콜을 사용한 통신을 담당한다.

파일 어댑터 아이콘으로 파일의 데이터 입출력을 방식을 사용한 통신을 담당한다.

HTTP 어댑터 아이콘으로 HTTP 프로토콜을 사용한 통신을 담당한다.
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아이콘 설명

ISO 8583 어댑터 아이콘으로 ISO 8583 프로토콜을 사용한 통신을 담당한다.

JMS 어댑터 아이콘으로 JMS API를 사용한 통신을 담당한다.

TCP 어댑터 아이콘으로 TCP 소켓을 이용해 TCP 프로토콜을 사용한 통신을 담당한다.

Tmax 어댑터 아이콘으로 Tmax 데이터베이스 시스템의 프로토콜을 사용한 통신을 담당한다.

Tuxedo 어댑터 아이콘으로 Tuxedo 프로토콜을 사용한 통신을 담당한다.

웹 서비스(WebService) 어댑터 아이콘이다.

WebDAV 어댑터 아이콘이다.

FTP 어댑터 아이콘으로 FTP 프로토콜을 사용한 통신을 담당한다.

MQ 어댑터 아이콘으로 MQ를 사용한 통신을 담당한다.

Pro_Object 어댑터 아이콘으로 ProObject 프로그램을 사용한 통신을 담당한다.

SAP 어댑터 아이콘이다.

SMTP 어댑터 아이콘으로 SMTP 프로토콜을 사용한 통신을 담당한다.

Log 어댑터 아이콘이다.

엔드포인트 그룹 아이콘이다.

인바운드 엔드포인트 아이콘이다.

아웃바운드 엔드포인트 아이콘이다.
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4. AnyLink 스튜디오
본 장에서는 스튜디오의 기본 화면구성에 대해서 설명한다.

4.1. 프로그램 시작
AnyLink 스튜디오는 AnyLink 제품군 중 하나로 플로우 서비스와 각종 어댑터들의 룰을 제작하고,
디플로이(Deploy)를 편리하게 할 수 있도록 도와주는 툴이다. 사용자는 GUI 환경의 AnyLink 스튜디오를 이용하여
플로우 또는 룰을 쉽게 편집하고 관리할 수 있다. 플로우 서비스 및 각종 어댑터에 대한 설명은 해당 안내서를
참고한다.

다음은 AnyLink 스튜디오를 시작하는 과정에 대한 설명이다.

1. AnyLink 스튜디오 프로그램을 시작하기 위해 바탕화면 아이콘( )을 클릭한다.

2. 스튜디오를 로딩하는 동안 AnyLink 로고, 저작 문구 및 진행 상태를 보여주는 화면이 나타난다.

스튜디오 실행 화면

3. 스튜디오를 실행하면 Workspace Launcher가 실행되고, Workspace를 설정할 수 있다. [OK] 버튼을
클릭하면 AnyLink 스튜디오가 실행된다.
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Workspace Launcher

4. 스튜디오 화면의 상단 툴바의  버튼을 클릭하면 로그인 화면으로 이동한다.

스튜디오는 각 사용자의 변경이력을 관리하기 위해 로그인을 필요로 한다. 로그인한 사용자가 서버에 디플로이한
정보는 변경이력으로 관리되며 사용자 간의 데이터 충돌을 감지하는 데 사용한다.

로그인 화면에서 서버 이름, 사용자 아이디, 패스워드, 서버 IP 주소 및 포트번호를 입력하고 [로그인] 버튼을
클릭하여 AnyLink 서버에 접속한다.

로그인 화면
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항목 설명

서버 이름 로그인 정보(주소, 포트, 사용자 아이디)가 저장된다.

서버 이름에는 로그인 아이콘을 통해 서버와 접속하지 않으면, 자동으로 로컬 모드에서
스튜디오를 사용할 수 있다.

IP Address DIS가 설치되어 있는 서버의 IP 주소이다.

포트번호 최초 설치할 때 7127로 설정되어 있다.

사용자 ID WebAdmin에서 사용자로 등록된 아이디이다.

패스워드 WebAdmin에서 설정된 패스워드이다.

로그인 화면에서 [편집] 버튼을 클릭하면 로그인 정보를 추가/편집/삭제할 수 있는 다이얼로그가 생성된다.

로그인 정보 편집 다이얼로그

5. 로그인에 성공하면 메인 화면이 나타난다.
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스튜디오 메인 화면

화면 아래에 다음과 같이 로그인 접속 정보가 표시된다.

스튜디오 메인 화면 - 로그인 정보

4.2. 화면구성
스튜디오는 하나의 큰 화면인 Workbench와 그 위에 여러 개의 Perspective(레이아웃)으로 구성된다.

다음은 AnyLink 스튜디오 초기화면이다.
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스튜디오 초기화면

• (1) Menu

Workbench의 메뉴를 보여준다. 각 메뉴에 대한 자세한 설명은 Menu�를 참고한다.

• (2) Tool bar

빠른 메뉴 실행을 위해 메뉴에 있는 명령 중 일부를 툴바에 표시한다. 툴바에 표시되는 메뉴 목록은 [Window] >
[Customize Perspective]에서 설정한다.

다음은 AnyLink에서 제공하는 툴바이다.

아이콘 설명

 (로그인) DIS에 접속한다.

 (로그아웃) DIS 접속을 해제한다.

 (관계도) 리소스의 연관 관계를 조회할수 있는 View를 생성한다.

• (3) Title bar

다음의 형식으로 Workbench의 타이틀이 표시된다.

{현재 Perspective 이름} – {현재 작업중인 파일명} – Tmax AnyLink Studio

• (4) Editor Panel
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서비스 플로우 다이어그램 편집기 등의 편집기가 위치한다.

• (5) Perspective

Perspective의 단축 버튼이 나타나며, 현재 활성화된 Perspective는 밝게 표시된다. 마우스 오른쪽 버튼을
클릭하면 나타나는 서브 메뉴에서 툴바에 표시되는 버튼에 대한 설정을 할 수 있다.

• (6) View

리소스를 탐색하고 리소스의 프로퍼티를 수정할 때 사용한다. 각 메뉴에 대한 자세한 설명은 View�를 참고한다.

• (7) 네비게이터

편집기를 지원하며, 대체로 Presentation 또는 Workbench의 정보 탐색을 제공한다. 자세한 설명은
네비게이터�를 참고한다.

4.2.1. Menu

Workbench는 다음의 메뉴로 구성된다.

• [File] 메뉴

파일 생성, 저장에 관련한 메뉴이다.

메뉴 설명

[New] 프로젝트 또는 파일을 생성한다.

[Open File] 일반적으로 이클립스(eclipse)에서 편집기를 여는 방법은 Service
Explorer에서 Workspace 안에 있는 파일을 마우스로 더블클릭을 하거나,
Service Explorer에서 파일을 선택한 후 컨텍스트 메뉴에서 [Open File]을
선택한다. 명령을 사용하면 Workspace 내에 있지 않은 파일을 열수 있다.

[Close] 현재 활성화된 편집기를 닫는다.

[Close All] 현재 열려 있는 모든 편집기를 닫는다.

[Save] 현재 활성화된 편집기 파일을 저장한다.

[Save As] 현재 활성화되어 있는 편집기 파일을 본래 이름이 아닌 다른 이름으로
변경하여 저장한다.

[Save All] 현재 열려있는 모든 편집기의 파일들을 저장한다.

[Revert] 현재 활성화된 편집기 파일을 마지막 저장한 상태로 되돌린다. 마지막 저장한
이후에 편집기에서 변경된 내용은 적용되지 않는다.

[Move] Service Explorer에서 선택한 파일 또는 폴더를 마우스로 끌어다가 다른
위치에 놓음으로써, 동일한 동작을 편리하게 수행할 수 있다.

[Rename] Service Explorer에서 선택한 파일 또는 폴더의 이름을 변경한다.
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메뉴 설명

[Refresh] Service Explorer에서 보여주는 Workspace의 내용을 실제 파일 시스템의
내용으로 새로고침한다.

Workspace 내의 프로젝트는 실제 파일 시스템과 동일한 내용을 보여준다.
Workbench 외부적으로 변경/추가/삭제된 파일에 대해서는 Workbench는
알지 못한다. 이러한 경우에 이 Refresh 명령을 사용함으로써
Workbench와 실제의 파일 시스템과 동기를 맞춘다.

[Convert Line Delimiters
To]

현재 활성화되어 있는 편집기의 라인 변경 구분자를
Window/Unix/MacOS9의 라인 변경자로 변경시킨다. 현재 Window가
디폴트로 설정되어 있다.

[Print] 현재 활성화되어 있는 편집기의 내용을 인쇄한다.

[Switch Workspace] 새 Workspace를 생성과 동시에 전환하거나 다른 Workspace로 전환한다.

[Restart] 스튜디오를 재시작하는 명령이다.

[Import] Wizard를 사용하여 외부의 프로젝트 또는 파일을 Workspace 내부로
가져온다.

[Export] Wizard를 사용하여 Workspace 내의 프로젝트 또는 파일을 외부로
내보내기(export)하는 명령이다. Wizard에서는 다양한 형태의 내보내기
방법을 제공한다.

[Properties] Service Explorer에서 선택한 리소스에 대해 속성 대화상자를 보여준다.

[Recent Files] Workbench에서 가장 최근에 작업한 파일의 목록을 보여준다.

[Recent Files]에 표시되는 파일의 최대 개수는 [Windows] >
[Preference] > [General] > [Editors] 메뉴에서 'Size of recently
opened files list' 항목을 변경한다.

[Exit] Workbench를 종료한다. Workbench를 종료하면 종료 시점의
Perspective와 열려있는 편집기 정보를 자동으로 저장하며, 다음에
Workbench를 열면 마지막에 저장된 Workbench 상태를 그대로 보여준다.

• [Edit] 메뉴

편집기에서 파일을 편집할 때 사용하는 메뉴이다.

메뉴 설명

[Undo] 마지막으로 편집한 내용을 취소한다.

[Redo] Undo 명령을 사용하여 마지막으로 취소한 내용을 다시 적용한다.

[Cut] 선택한 내용을 클립보드로 복사하고, 원본을 삭제한다.

[Copy] 선택한 내용을 클립보드로 복사한다.

[Paste] 클립보드에 있는 텍스트나 객체를 활성화되어 있는 편집기 또는 뷰의 커서
위치에 삽입한다.

[Delete] 선택한 내용을 삭제한다.
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메뉴 설명

[Select All] 현재 활성화되어 있는 편집기 또는 뷰의 모든 텍스트나 객체를 선택한다.

[Find/Replace] 현재 활성화되어 있는 편집기에서 표현식을 검색하고 선택적으로 표현식을 새
표현식으로 변경한다.

[Add Bookmark] 활성화되어 있는 편집기에서 커서가 있는 행에 책갈피를 추가한다.

현재 표시되어 있는 책갈피의 리스트는 [Window] > [Show View] >
[Other] 메뉴를 선택하여 나타나는 Show View 대화상자의 [General] >
[Bookmark]에서 조회할 수 있다.

[Add Task] 활성화되어 있는 편집기에서 커서가 있는 행에 태스크를 추가한다.

현재 표시되어 있는 태스크의 리스트는 [Window] > [Show View] > [
Other] 메뉴를 선택하여 나타나는 Show View 대화상자의 [General] >
[Tasks]에서 조회할 수 있다.

• [Navigate] 메뉴

Workbench 상의 리소스 및 항목들을 찾거나 탐색하는 메뉴이다.

메뉴 설명

[Go Into] 현재 활성화되어 있는 뷰가 Tree View일 경우, 현재 선택된 아이템이 트리의
루트가 되도록 한다.

트리의 루트는 트리에 나타나지 않는 Invisible Root를 말한다.

[Go To] • Back : HTML 브라우저의 [이전] 또는 [뒤로] 버튼과 유사하다.
활성화되어 있는 뷰를 Go Into 명령이 실행되기 이전 모습으로
되돌린다.

• Forward : HTML 브라우저의 [다음] 또는 [앞으로] 버튼과 유사하다.
활성화되어 있는 뷰를 Go To의 Back 명령이 실행되기 이전의 모습으로
되돌린다.

• Up One Level : 현재 노드의 루트를 부모 루트로 하여, 트리에서 보이는
레벨을 한 수준 올린다.

[Open from Clipboard] 클립 보드로부터 저장된 항목을 open한다.

[Show In] 다른 뷰에서 현재 활성화되어 있는 뷰의 콘텐츠를 볼 수 있도록 한다.

[Next] 현재 활성화되어 있는 뷰에서 목록 또는 테이블의 다음 항목을 탐색한다.

예를 들어 Search View가 활성화되면 다음의 검색 항목을 탐색한다.

[Previous] 현재 활성화되어 있는 뷰에서 목록 또는 테이블의 이전 항목을 탐색한다.

예를 들어 Search View가 활성화되면 이전의 검색 항목을 탐색한다.

[Last Edit Location] 마지막으로 편집한 위치로 이동한다.

[Back] 편집기에서 이전 위치로 이동한다.
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메뉴 설명

[Forward] 편집기에서 back 명령을 취소하기 위하여 사용한다.

back 명령이 수행되기 이전의 위로 이동한다.

• [Search] 메뉴

Workbench에서 파일 또는 텍스트를 검색할 수 있는 메뉴이다.

메뉴 설명

[Search] 파일과 Java 소스 내에서 검색한다.

[File] 파일과 Java 소스 내에서 검색한다.

[Text] 선택한 내용을 Workspace 내에서 검색한다.

• [Project] 메뉴

Workspace 내의 프로젝트에 관련한 메뉴이다.

메뉴 설명

[Open Project] 현재 선택한 프로젝트를 연다.

이 명령을 수행하기 위해서는 선택한 프로젝트가 닫혀 있어야 한다.

[Close Project] 현재 선택한 프로젝트를 닫는다.

이 명령을 수행하기 위해서는 선택한 프로젝트가 열려 있어야 한다.

[Build All] Workbench의 모든 프로젝트에 대해 증분 빌드(Incremental Build)를
수행한다. 즉, 마지막으로 증분 빌드를 수행한 후 Workbench에 변경된
리소스가 있으면 해당 리소스를 모두 빌드(컴파일)한다.

이 명령은 [Project] > [Build Automatically] 메뉴를 체크하지 않은
경우에만 사용이 가능하다.

[Build Project] 현재 선택한 프로젝트에 대해 증분 빌드를 수행한다. 즉, 마지막으로 빌드를
수행한 후 변경된 리소스가 있으면 해당 리소스를 모두 빌드한다.

이 명령은 [Project] > [Build Automatically] 메뉴를 체크하지 않은
경우에만 사용이 가능하다.

[Build Working Set] 사용자가 지정한 프로젝트(working set)에 대하여 증분 빌드를 수행한다. 즉,
마지막으로 빌드한 후 리소스 변경사항에 의해 영향을 받는 working set에
있는 모든 리소스를 빌드한다.

이 명령은 [Project] > [Build Automatically] 메뉴를 체크하지 않은
경우에만 사용이 가능하다.
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메뉴 설명

[Clean] 이전 빌드 결과를 모두 삭제한다.

[Project] > [Build Automatically] 메뉴가 체크되어 있으면, 기본적으로
현재 프로젝트에 대해 다시 빌드를 수행한다.

[Build Automatically] 이 메뉴 항목에 체크되어 있으면, Workbench에서 리소스가 변경되어
저장이 필요할 경우에 자동으로 증분 빌드를 수행한다.

[Properties] 선택한 프로젝트 또는 선택한 리소스를 포함하는 프로젝트의 속성을 표시하는
대화상자를 연다.

• [Run] 메뉴

컴파일을 실행하거나 컴파일에 사용되는 도구 등을 설정한다.

메뉴 설명

[Run As] 설정된 컴파일 툴로 컴파일을 수행한다.

[External Tools
Configurations]

컴파일 등을 수행할 외부 툴을 설정한다.

[Organize Favorites] 설정한 외부 툴을 즐겨찾기에 등록하여 [Run As] 메뉴에서 쉽게 사용하도록
한다.

• [Window] 메뉴

Workbench 화면에서 Perspective 또는 뷰 등을 열고 닫거나 설정하는 메뉴이다.

메뉴 설명

[New Window] 현재 Perspective와 동일한 Perspective가 있는 새로운 Workbench
화면을 연다.

[New Editor] 현재 선택한 파일을 새로운 편집기에서 연다.

[Hide Toolbar] 상단에 위치한 툴바를 화면에서 숨긴다.

[Open Perspective] 원하는 Perspective를 선택하여 연다.

[Show View] 원하는 뷰를 선택하여 화면에 띄운다.

AnyLink 스튜디오에서 작업할 때 필수적인 뷰만 서브 메뉴에 나타나며, 이
외의 다른 뷰를 조회하려면 [Other] 서브 메뉴에서 다른 뷰를 선택한다.

[Customize Perspective] 현재 Perspective에서 나타나는 메뉴, 툴바 명령 등을 설정한다.

[Save Perspective As] 기존 Perspective를 재설정하거나 현재의 Perspective를 다른 이름으로
저장한다.

[Reset Perspective] 현재의 Perspective를 원래의 레이아웃으로 복원한다.

[Close Perspective] 현재 활성화된 Perspective를 닫는다.

[Close All Perspectives] Workbench에 열려 있는 모든 Perspective를 닫는다.
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메뉴 설명

[Navigation] Workbench 화면에서 뷰, 편집기, Perspective를 이동하기 위한 메뉴이다.
이 메뉴에 표시된 단축 키를 이용하면 마우스를 사용하지 않고 키보드
만으로도 Workbench 안의 화면을 탐색할 수 있다.

다음은 서브 메뉴에 대한 설명이다.

• [Show System Menu] : 현재 뷰 또는 편집기 크기를 조정하거나 닫을
수 있는 시스템 메뉴를 보여준다.

• [Show View Menu] : 현재 활성화되어 있는 뷰에서 리스트 메뉴를
보여준다.

• [Quick Access] : 문자열을 입력하여 리소스를 빠르게 검색할 수 있다.

• [Maximize / Minimize Active view or Editor] : 현재의 뷰 또는
편집기를 전체 화면으로 하거나, 전체 화면인 경우에는 원래대로
되돌린다.

• [Activate Editor] : 현재의 편집기를 활성화시킨다.

• [Next Editor] : 가장 최근에 사용한 편집기 목록에서 다음 편집기로
이동한다.

• [Previous Editor] : 가장 최근에 사용한 편집기 목록에서 이전의
편집기로 이동한다.

• [Switch to Editor] : 현재 열려있는 편집기 목록을 보여주며, 선택한
편집기로 전환할 수 있다. 편집기 목록에서 편집기를 선택하면 해당
편집기가 활성화된다.

• [Next View] : 가장 최근에 사용한 뷰 목록에서 다음 뷰로 이동한다.

• [Previous View] : 가장 최근에 사용한 뷰 목록에서 이전 뷰로
이동한다.

• [Next Perspective] : 가장 최근에 사용한 Perspective 목록에서
다음의 Perspective로 이동한다.

• [Previous Perspective] : 가장 최근에 사용한 Perspective 목록에서
이전의 Perspective로 이동한다.

[Preferences] Workbench 또는 설치되어 있는 모든 플러그인에 대한 환경을 설정하는
화면이 나타난다.

스튜디오 리소스는 XML 형식으로 생성되므로 [General] > [Workspace]
화면의 'Text file encoding' 항목은 'UTF-8’로 설정한다.

• [Help] 메뉴

도움말, 제품 정보를 볼 수 있는 메뉴이다.

메뉴 설명

[Help Contents] 도움말 목록 및 상세 도움말을 제공한다.
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메뉴 설명

[Search] 도움말 내용을 검색할 수 있는 검색 화면 열린다.

[Dynamic Help] 관련 토픽별로 도움말을 검색할 수 있는 화면이 열린다.

[Key Assist] 각 메뉴 항목의 단축 키에 대한 정보를 제공한다.

[Cheat Sheets] 설치된 소프트웨어에 대한 Cheat Sheets를 선택할수 있는 화면을 제공한다.

[Check for Updates] 설치된 소프트웨어 목록과 업데이트 상태를 보여준다.

[Install New Software] 검색을 통해 소프트웨어 목록을 보여주고, 설치할 수 있는 화면을 제공한다.

[About Tamx AnyLink
Studio]

AnyLink 스튜디오의 제품 정보를 제공한다.

4.2.2. View

편집기를 지원하며, 대체로 Presentation 또는 Workbench의 정보 탐색을 제공한다. 뷰는 단독으로 나타날 수도
있고 탭이 달린 형태(노트북)로 다른 뷰와 함께 나타날 수도 있다. Workbench는 탭이 화면의 상단 또는 하단에
있는지 여부를 포함하여 편리하고 신속한 여러 환경 구성 방법을 제공한다.

탭이 달린 노트북의 일부인 뷰를 활성화하려면 해당 탭을 클릭한다.

다음은 각 탭에 대한 설명이다.

• [Project Explorer]

Workspace 내의 리스트를 보여주며, 특정 리소스를 선택하여 편집기를 여는 등의 동작을 수행한다.

• [Console View]

스튜디오 사용의 여러 정보(디플로이 과정, 에러 메시지 등)를 조회한다.

• [Error Log View]

Workbench 수행 중 에러가 발생한 경우에 로그를 조회한다.

• [Outline View]

활성화되어 있는 편집기의 내용에 대한 개요를 조회한다.

• [Properties View]

Workbench에서 선택된 객체의 상세 정보를 보여주고 수정할 수 있다.

• [Debug View]

플로우 디버거 결과를 조회한다.
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디버거 View 화면

• [관계도 View]

리소스 간의 연관 관계를 조회한다.

관계도 View 화면

4.2.3. 네비게이터

네비게이터는 단독으로 나타날 수도 있고 탭이 달린 형태로 다른 네비게이터가 함께 나타날 수도 있다. 탭이 달린
노트북의 일부인 네비게이터를 활성화하려면 해당 탭을 클릭한다. Workbench는 탭이 화면의 상단 또는 하단에
있는지 여부를 포함하여 편리하고 신속한 여러 환경 구성 방법을 제공한다.

다음은 AnyLink 네비게이터의 초기화면이다.
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AnyLink 네비게이터

다음은 네비게이터 컨텍스트 메뉴에 대한 설명이다.

메뉴 설명

[새로 만들기] AnyLink에서 제공하는 서비스(거래, 플로우, 아웃바운드 등)를 생성할 수 있는
화면을 제공한다.

[다운로드] 서버와 연결이 가능한 상태에서 사용할 수 있으며, DIS에서 리소스
다운로드한다.

[템플릿] 공통 설정을 가진 리소스들을 여러 개를 빠르게 생성할 수 있는 템플릿을
생성하거나 DIS에 업로드할 수 있다.

[업무시스템 할당] 현재 활성화된 프로젝트를 배포할 때 해당 프로젝트의 리소스를 RTE(RunTime
Engine Server)에 반영하는 메뉴이다.

로컬 모드에서 실행하면 로그인 화면이 실행된다.

[업무시스템 할당 해제] RTE에 반영되었던 리소스를 해제시키는 메뉴이다.

로컬 모드에서 실행하면 로그인 화면이 실행된다.

[Configuration 가져오기] DIS에 등록되어 있는 설정 파일을 가져와 설정 정보들을 스튜디오에 등록한다.
(예: 거래 타입)

[새로고침] Service Explorer에서 보여주는 Workspace의 내용을 실제 파일 시스템의
내용으로 새로고침한다. Workspace 내의 프로젝트는 실제로 파일 시스템과
동일한 내용을 보여준다.

Workbench 외부적으로 변경, 추가 또는 삭제된 파일에 대해서는
Workbench는 알지 못한다. 이러한 경우에 이 새로고침 명령을 사용함으로써
Workbench와 실제의 파일 시스템과 동기를 맞춘다.
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메뉴 설명

[붙여넣기] 복사한 프로젝트 또는 파일을 붙여넣기 한다.

[삭제하기] 내부의 프로젝트 또는 파일을 삭제하는 메뉴이다.

[가져오기] 외부의 프로젝트 또는 파일을 네비게이터 내부로 가져온다.

[내보내기] 내부의 프로젝트 또는 파일을 외부로 내보낸다.

[Validate] 소스 유효성 검사를 수행한다.

[Team] SVN 등과 같은 시스템과 연동하여 팀 단위의 소소를 관리한다.

[Compare With] 리소스들을 비교한다.

[Replace With] History를 이용하여 리소스를 변경한다.

 버튼을 클릭하면 리소스 표현 방식을 설정할 수 있는 다이얼로그가 생성된다.

네비게이터 옵션 - 리소스 표현 방식

다음은 네비게이터 리소스 표현 방식 변경방법에 대한 설명이다.

옵션 설명

리소스 이름으로 보여주기 옵션을 설정할 때 리소스 이름이 네비게이터에 표시된다. 옵션을 설정하지 않으면
리소스 아이디가 네비게이터에 표시된다.

서버 버전 표시 로그인 상태에서 거래(그룹) 리소스에 표시되는 정보로 DIS에 배포되어 있는 리소스의
버전을 출력한다.
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옵션 설명

배포 상태 표시 로그인 상태에서 거래(그룹) 리소스에 표시되는 정보로 해당 리소스의 배포/배포해제
상태를 출력한다.

배포 시간 표시 로그인 상태에서 거래(그룹) 리소스에 표시되는 정보로 해당 리소스가 DIS에
마지막으로 배포된 시간을 출력한다.

리소스 정렬 방식 '리소스 타입' 항목을 선택한 경우 하단에 설정된 리소스 타입 순서로 정렬되며,
'리소스 타입' 항목을 선택하지 않은 경우 리소스 종류에 관계 없이 리소스 이름 순으로
정렬이 된다.

4.3. 리소스
리소스를 생성하기 위해 활성화된 왼쪽 네비게이터의 컨텍스트 메뉴에서 [새로 만들기]를 선택한다. 리소스 생성에
대한 세부 사항은 각 절에서 설명한다.

다음은 AnyLink에서 생성할 수 있는 리소스에 대한 설명이다.

리소스 설명

프로젝트 서비스 플로우 다이어그램을 그리려면 먼저 Workspace에 AnyLink 프로젝트를
생성해야 한다.

AnyLink 프로젝트는 AnyLink 리소스를 관리하기 위한 최상위 단위이다. AnyLink
프로젝트 하위의 리소스들은 상호참조 및 연관을 맺을 수 있으며, 패키지 단위로
통일된다.

거래/거래그룹 거래는 AnyLink에서 제공하는 비즈니스 서비스이다.

클라이언트로부터 요청 메시지를 받아서 백엔드 서비스를 호출하고 결과를 받아 응답
메시지를 전달하기까지 일련의 처리를 의미한다. 거래/거래그룹 리소스를 이용하여
거래그룹, 트리, 메시지 등을 생성/수정할 수 있다.

멀티 바인딩 멀티바인딩 라우터 룰은 AnyLink의 서비스 중 하나로 어댑터의 파싱 룰을 통해서
멀티바인딩 룰을 호출할 수 있다.

AnyLink 내부 서비스를 경우에 따라 다르게 라우팅을 해야 할 경우 여러 서비스를
묶어서 하나의 그룹으로 조회한다.

아웃바운드 룰 AnyLink의 내부 서비스로 AnyLink에서 외부 시스템을 호출하고, 그 결과 응답을
받는 역할을 한다.

내부적으로 다른 컴포넌트에서 아웃바운드 룰 서비스를 호출하면 해당 룰에 설정된
어댑터와 엔드포인트를 식별하여 외부 시스템으로 메시지를 전송하는 방식으로
동작한다.
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리소스 설명

WSDL WSDL(Web Services Description Language)는 메시지를 주고받으며 동작하는
엔드포인트들로 네트워크 서비스의 인터페이스를 기술하는 XML 포맷이다.
오퍼레이션과 메시지는 추상적으로 정의하고 네트워크 프로토콜과 메시지 포맷을
바인딩하여 실제 엔드포인트의 인터페이스를 기술한다.

또한 WSDL은 특정 메시지 포맷과 네트워크 프로토콜에 제한되지 않고 확장하여
다양한 네트워크 인터페이스를 나타낼 수 있도록 구성되어 있다.

외부 매핑 메시지 간 DataObject의 매핑을 정의하는 리소스이다.

플로우 서비스 플로우는 비즈니스 프로세스를 모델링하는데 사용되는 표준인
BPMN(Business Process modeling Notation)을 차용한 다이어그램을 통해
프로세스의 흐름을 표현한다.

AnyLink 스튜디오를 통해 액티비티와 이벤트로 구성된 다이어그램 형태로 정의하며,
프로세스 흐름 외에 변수, 표현식, 매핑 등의 기능을 제공한다. 즉, 서비스 플로우는
서비스의 수행 절차를 그래프의 형태로 표현한 것이다.

유저클래스, 핸들러 거래에서 플로우는 제어의 흐름을 구조화하기 위하여 조건(condition)을 기술한다.
이런 조건은 표현식을 통해 하나의 문장형태로 프로세스 내의 변수를 이용하여
정의한다. 표현식으로 정의할 수 있는 로직보다 복잡한 로직을 정의해야 할 경우 유저
클래스 액티비티 또는 핸들러를 정의한다.

메시지 메시지는 서비스 간의 데이터를 교환하는데 사용하는 기본 데이터 형태로 전문을
추상화(abstraction)시킨 객체이다.

공통 업무 프로젝트 동일한 업무시스템을 가지는 프로젝트에 대해서 공통으로 사용할 수 있는 리소스들의
집합이다.
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5. AnyLink 안내서 구성
본 장에서는 AnyLink 안내서에 대한 내용을 간략히 소개한다.

5.1. 개요
제품에 대한 안내서가 있어도 제품에 대해 여러 가지 안내서가 존재하다 보니 제품을 처음 접하거나 제품에 익숙하지
않은 사용자는 원하는 안내서를 찾는데 문제를 겪을 수 있다. 본 장에서는 안내서 사용에 있어 사용자의 편의를 돕기
위해 AnyLink 안내서를 어떻게 활용할 수 있는지 기술한다. 즉, AnyLink 안내서에는 어떤 것들이 있고, 각
안내서에서 어떤 내용을 기술하고 있으며, 각 안내서가 다른 안내서와 어떻게 연관을 맺고 있는지에 대해 기술한다.

AnyLink 안내서를 처음 접하는 사용자는 본 장을 주의 깊게 읽어볼 것을 권장한다. 비록 본 장이 실제 제품 사용법과
직접적인 관련이 있는 것은 아니지만, 안내서 구성을 전체적으로 이해하는 데 도움이 되도록 작성되었다.

5.2. 안내서 목록
AnyLink 안내서 목록은 다음과 같다.

No 안내서 설명

1 AnyLink Release Note 릴리스된 버전의 주요 변경내역에 대해서 기술한다.

2 AnyLink 소개 AnyLink의 기본 구성요소와 서버, 스튜디오, WebAdmin의
기본 내용을 설명한다.

3 AnyLink 시작하기 AnyLin의 기본개념을 소개하고 TCP/HTTP, 웹 서비스 거래를
생성하는 과정을 설명한다.

4 AnyLink 설치 안내서 AnyLink 서버, 스튜디오, 리모트 에이전트를 설치하는 과정을
설명한다.

5 AnyLink 스튜디오 안내서 GUI 기반에서 플로우 서비스와 각종 어댑터 룰을 제작 및
배포하는 툴 안내서이다.

6 AnyLink WebAdmin 안내서 WebAdmin를 사용하여 시스템을 관리하는 방법에 대해
설명한다.

7 AnyLink 런타임 엔진 서버 안내서 AnyLink 런타임 엔진 서버와 리소스, 서비스 플로우 엔진,
멀티바인딩 라우터, 서버 API의 사용법에 대해서 설명한다.

8 AnyLink DB 어댑터 사용자 안내서 WebAdmin과 스튜디오에서 DB 어댑터의 환경설정, 생성,
배포, 테스트하는 과정에 대해서 기술한다.

9 AnyLink ebXML 어댑터 사용자 안내서 WebAdmin과 스튜디오에서 ebXML 어댑터의 환경설정,
생성, 배포, 테스트하는 과정에 대해서 기술한다.

10 AnyLink File 어댑터 사용자 안내서 WebAdmin과 스튜디오에서 File 어댑터의 환경설정, 생성,
배포, 테스트하는 과정에 대해서 기술한다.

11 AnyLink FTP 어댑터 사용자 안내서 WebAdmin과 스튜디오에서 FTP 어댑터의 환경설정, 생성,
배포, 테스트하는 과정에 대해서 기술한다.
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12 AnyLink MQ 어댑터 사용자 안내서 WebAdmin과 스튜디오에서 MQ 어댑터의 환경설정, 생성,
배포, 테스트하는 과정에 대해서 기술한다.

13 AnyLink SAP 어댑터 사용자 안내서 WebAdmin과 스튜디오에서 SAP 어댑터의 환경설정, 생성,
배포, 테스트하는 과정에 대해서 기술한다.

14 AnyLink TCP 어댑터 사용자 안내서 WebAdmin과 스튜디오에서 TCP 어댑터의 환경설정, 생성,
배포, 테스트하는 과정에 대해서 기술한다.

15 AnyLink Tmax 어댑터 사용자 안내서 WebAdmin과 스튜디오에서 Tmax 어댑터의 환경설정, 생성,
배포, 테스트하는 과정에 대해서 기술한다.

16 AnyLink 웹 서비스 어댑터 사용자 안내서 WebAdmin과 스튜디오에서 웹 서비스 어댑터의 환경설정,
생성, 배포, 테스트하는 과정에 대해서 기술한다.

17 AnyLink ProFrame Java(EJB) 어댑터
사용자 안내서

WebAdmin과 스튜디오에서 ProFrame Java(EJB) 어댑터의
환경설정 과정에 대해서 기술한다.
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